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Overview

¢ |ISO TC194 Structure, Function
» Background & History
¢ |ISO TC194 Current Standards

* Risk Management Evolution



ISO Structure/Function

162 member countries — the national standards bodies worldwide

Nearly 300 Technical Committees within ISO

In the US, the National Standards body is ANSI

AAMI is the ANSI delegated organization that develops and publishes TC194 Stds
ISO TC194 Stds are the ISO 10993 series
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Mission of ISO TC194

TC 194 will contribute indirectly to public health and well-
being by developing standards for medical devices -
conformity to the standards by manufacturers will ensure
their products do not compromise the biological and clinical
safety of patients through:

* Protection of the health and safety of the patient and user

« Elimination of trade barriers through global harmonization

* Uniformity of test methods

« Uniformity of reference materials

* Uniformity of terminology and definitions

* Quality products used in medical devices

« Effective and efficient use of resources in standards development
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I1SO TC194 Countries

?ﬂ%’

@ Seccretariat @ Participating Countries (24) @ Observing Countries (24)
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ISO TC194 /10993 Standards
Background & History

Medical Device Safety Assessment Evolution

| I 1 1 1

Compendial TriPartite ISO 10993 FDA G95 ISO 10993 -
(USP, EP, Agreement Initiated: Bluebook Risk

others) tests developed: N. America, memo: Management
developed US, UK, Europe, “formal” Approach
largely for Canada Asia FDA

raw material acceptance

screening of ISO 10993

purposes
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Device Biological Testing:
Described in ISO 10993-1

Materials/devices categorized according to:

L)

* Body Contact:
Surface devices: skin, mucosal membranes,
breached body surfaces
External communicating devices: blood path-indirect, blood
path-circulating, tissue/bone
Implant devices: tissue/bone, blood

4

L)

» Duration of Use:

A. Limited: < 24 hours

B. Prolonged: > 24 hours but <30 days
C. Permanent. > 30 days

L)
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Categories of Medical Devices
& Materials of Construction

Examples:
Surface Device Externally Implant Device
S| g | T
Gloves Blood Sets CSF Shunts
Endotracheal Tubes IV Catheters Heart Valves
Orthodontic Devices / Dental Cements & Vascular Grafts

Dental Prostheses Dental Filling Materials
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Standards in ISO TC194

5

ISO 10993—-1:2009

+ Cor 1:2010

1ISO 10993—-2:2006

ISO 10993-3:2003

1ISO 10993—4:2002

+ Amd 1:2006

ISO 10993-5:2009

1ISO 10993-6:2007

ISO 10993-7:2008

+ Cor 1:2009

1ISO 10993-9:2009

ISO 10993-10:2010

1ISO 10993—-11:2006

ISO 10993-12:2007

1ISO 10993-13:2010

ISO 10993—-14:2001

1ISO 10993—-15:2000

ISO 10993-16:2010

1ISO 10993-17:2002

ISO 10993-18:2005

ISO/TS 10993-19:2006

ISO/TS 10993-20:2006

Published ISO deliverables Stage 60.60

Biological evaluation of medical devices - Part 1: Evaluation and testing
within a risk management process

Biological evaluation of medical devices — Part 2: Animal welfare
requirements

Biological evaluation of medical devices — Part 3: Tests for genotoxicity,
carcinogenicity and reproductive toxicity

Biological evaluation of medical devices — Part 4: Selection of test for
interactions with blood

Biological evaluation of medical devices — Part 5: Tests for in vitro
cytotoxicity

Biological evaluation of medical devices — Part 6: Tests for local effects
after implantation

Biological evaluation of medical devices — Part 7: Ethylene oxide
sterilization residuals

Biological evaluation of medical devices — Part 9: Framework for
identification and quantification of potential degradation products

Biological evaluation of medical devices — Part 10: Tests for irritation and
skin sensitization

Biological evaluation of medical devices — Part 11: Tests for systemic
toxicity
Biological evaluation of medical devices — Part 12: Sample preparation

and reference materials

Biological evaluation of medical devices — Part 13: Identification and
quantification of degradation products from polymeric medical devices

Biological evaluation of medical devices — Part 14: ldentification and
quantification of degradation products from ceramics

Biological evaluation of medical devices — Part 15: Identification and
quantification of degradation products from metals and alloys

Biological evaluation of medical devices — Part 16: Toxicokinetic study
design for degradation products and leachables

Biological evaluation of medical devices — Part 17: Establishment of
allowable limits for leachable substances

Biological evaluation of medical devices — Part 18: Chemical
characterisation of materials

Biological evaluation of medical devices — Part 19: Physico-chemical,
morphological and topographical characterization of materials

Biological evaluation of medical devices — Part 20: Principles and methods
for immunotoxicology testing of medical devices
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ISO/DIS 10993-6
(Revision)

7

ISO 10993-4.2
(Revision)

1ISO/CD 10993-5

(Revision)

8

ISO/AWI 10993-7

ISO/AWI TS 29741

9

ISO/NP 10993-1

ISO/NP 10993-9

ISO/NP 10993-11

ISO/NP 10993-15

ISO/NP 10993-16

ISO/NP 10993-18

ISO/NP TS 10993-19

ISO/NP TS 10993-20

ISO/NP TR 10993-22

10

ISO/PWI 10993-17

Draft International Standards (ISO/DIS) Stage 40.60
Biological evaluation of medical devices — Part 6: Tests for local effects
after implantation

Committee Draft (ISO/CD) Stage 30.60

Biological evaluation of medical devices - Part 4: Selection of tests for
interactions with blood

Biological evaluation of medical devices -- Part 5: Tests for in vitro
cytotoxicity
Approved Work Items (ISO/AWI) Stage 20.00

Biological evaluation of medical devices -- Part 7: Ethylene oxide
sterilization residuals

Biological evaluation of medical devices -- Development of tolerable intake
values for Di(2-ethylhexyl)phthalate (DEHP)
New projects approved (ISO/NP) Stage 10.99

Biological evaluation of medical devices - Part 1: Evaluation and testing
within a risk management process

Biological evaluation of medical devices -- Part 9: Framework for
identification and quantification of potential degradation products

Biological evaluation of medical devices - Part 11: Tests for systemic
toxicity

Biological evaluation of medical devices —- Part 15: Identification and
quantification of degradation products from metals and alloys

Biological evaluation of medical devices -- Part 16: Toxicokinetic study
design for degradation products and leachables

Biological evaluation of medical devices —- Part 18: Chemical
characterization of materials

Biological evaluation of medical devices — Part 19: Physico-chemical,
morphological and topographical characterization of materials

Biological evaluation of medical devices -- Part 20: Principles and
methods for immunotoxicology testing of medical devices

Biological evaluation of medical devices - Part 22: Guidance on
nanomaterials

Preliminary Work Items (ISO/PWI) Stage 00.00

Biological evaluation of medical devices — Part 17: Establishment of
allowable limits for leachable substances
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Current - ISO 10993 Part 1

Evaluation within a risk management process
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Risk Management Evolution:
Regulatory Environment

[Decision to ][Decision to] PDR ( CDR ) ¢

Investigate Proceed
I Idea I I Early Development I I Implementation I
| | |
‘ Concept Definition/ IProduct/Process Developmentl |Market|ntro. Continuous4
Feasibility . | Support
I Validation I

» Market and » Project Team » Product/Process » Product/Process » Field Quality
Technical » Requirements Verification Validation Monitoring
Assessment Definition/Design » Regulatory Plan »  Final Design »  Plant Quality

» Operating Plan Inputs »  Shelf Life Studies Review(s) Feedback

» Design Options » PMA/510(k) Submission »  Supplier Approval » Key Project
» Environmental » Design Review(s) » Manufacturing Lessons Learned
Assessment »  Clinical Appropriateness Specifications
»  Preliminary Design Review » Clinical
Review (s) Appropriateness
Review
PDR - Preliminary Decision Review » PMA/510(k) Clearance

CDR - Critical Decision Review
FDR - Final Decision Review
PLR - Post Launch Review
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Risk Management Evolution:
Regulatory Environment




Risk Management Evolution:
Challenges

* Device biocompatibility evaluation iIs complex!

» Constantly shifting regulatory environment

» Chemical and physical hazards to consider
« Assessment of risks from material-tissue interactions, debris, etc.
* Assessment of risks from leachable chemicals and mixtures

» Device biocompatibility experts as risk

managers
» What does risk management mean?

» How can we be risk managers?
» Helping to reduce adverse events needs to be considered
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Risk Management Evolution:
Progress & Answers

» Better tools & communication options

» FDA and other agencies more open to early/often
communication

» Evolving assessment methods
= E.g., chemical characterization (ISO 10993-18) and risk assessment (ISO 10993-17)

» Better analytical methods for physical interactions
= E.g., new imaging tools

* Risk management

» Adverse event and recall tracking
» Emerging options for more “holistic” risk management
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Risk Management Evolution:
Evolving Tools: Ex 10993-17

Annex B
(informative)

Risk assessment for mixtures of leachable substances

If the compounds being leached from a device exert their effects via a common toxicological mechanism of action or
are structurally similar to one another (e.g., phthalate esters, acrylates, methacrylates), and the dose of these
compounds received by a patient is well below the respective Tl value faor each compound, it can be assumed that
any effects will occur in an additive fashion; that is, the combined effects of two or more agents is equal to the sum of
the effects of each agent given alone. As a result, a hazard index (HI) approach can be used to estimate the
likelihood that adverse effects will occur following exposure to the mixture. An HI can be calculated as follows:

" dose; (B.1)

A= Z Tl;

j:=

where
i 15 the number of components of the mixture;
dose; Is the dose of each compound received by the patient, in miligrams per day;
Tl; 15 the tolerable intake, in milligrams per day, of each compound.
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Risk Management Evolution:
Evolving Tools: Ex 10993-17

Tolerable Intake (TI)

TI = NOEL, LOEL, or other endpoint
Modifying Factor (MF)

MF = UF1 x UF2 x UF3

UF1: inter-individual differences
UF2: inter-species differences
UF3: quality/relevance of database

Then, tolerable exposure (TE):

TE=TIxmx UTF m = body mass; UTF = device utilization factor

Finally, a device maximum allowable limit value (mass of leachable[s]):

m=TEXBF xD BF = benefit factor; D = days in a device category
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Risk Management Evolution:

Evolving Tools: Ex TTC

ISO 10993

* Threshold of Toxicological Concern (TTC)

» Emerging concept for medical devices

Proposed
Approach:
assign
single TTC

for all

Initial consideration as per ISO 10993-1

]

Conduct materials charactenzation as per
1SO 10993-18 to determine if any
excluded classes of chemicals are present
{N-Nitroso compounds, Endocrine
disruptors, strained heteronuclear rings,
Heavy metal, Alpha-nitro furyl

(.
compounds, Hydrazines/triazenes/azides/ \
azoxy compounds, Polycyclic amines, & N
T Organophosphorous compounds) - %
Cgfiduct materialshy : #
ichgfacterization as pe No Yes h "
ISO 10993-18 to £ -~
,eachab’es etermine chemical Use of TN Appef™
ructurs and guantity. pprofy Jse
Is any chemical Al ‘e Me&tiods for
Assk--ing Risk (e.g.
" ~aical testing)
Yes
Does tif
chemicai have
any Structural
Complets Alerts for
Chemical Genotoxicity (e.g.
Risk DEREK or Ashby/
Assessment Tennes)?
Is the chemical IConfirm daily exposure)
presentat =90 of chemical is >0.15
ugdRerson No Yes ua/person
Use of TTC
Use of TTC
] Yes Approach not No Yes
appropnate, Use
Complete Alternate Methods Complete
Chemical for Assessing Risk
Risk {e.g. biclcgical
Assessment

PERU Workshop on Medical Device Regulation and Standards: Policy and Technical Aspects

Chemical
Risk
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Approach not
appropriate, Use
Alternate
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Risk Management Evolution:
Adverse Events

Serious Adverse Events (SAEs)

« A serious adverse event (experience) or reaction is any
untoward medical occurrence that:
— results in death,
— Is life-threatening,

— requires in-patient hospitalization or prolongation of existing
hospitalization,

— is a congenital anomaly/birth defect.

NOTE: The term “life-threatening” in the definition of “serious” refers to an event in which
the patient was at risk of death at the time of the event; it does not refer to an event
which hypothetically might have caused death if it were more severe.
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Risk Management Evolution:
Device SAE Trends
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Risk Management Evolution:
Reducing SAE’s

* The medical device industry lacks a
prospective risk prediction tool and index

 These tools exist elsewhere; insurance
Industry uses them to predict:

— Floods

— Earthquakes

— Natural disasters
— And so on



Risk Management Evolution:
Manufacturers / Users

e Unprecedented challenges

— Pricing pressures

 Health care reform / reduced reimbursement / medical device
excise tax

« Competition from emerging markets
— Reduced R&D pipelines / innovation deficit
— Regulatory challenges / complexity of approval processes
— Increasing supply chain complexity and risk
— Mergers & Acquisitions
— Others
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Risk Management Evolution:
Ex New Risk Scoring Methods

* Total risk scores based on quantitative
elements in a number of categories
including:

— Testing features and results

— Therapeutic properties/clinical info
— Acquisition info (if relevant)

— APl supplier info, spec status, etc
— Mfg process

— Supply chain

— Operational

— Performance & QC testing

— Distribution

— Regulatory compliance

— Field performance

— Others

* Multiple scoring elements in each category
leads to overall risk scores

Product A

Product B

Product C

Risk Scores
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Conclusions

Device biocompatibility — unique
challenges

ISO 10993 Standards promote uniformity,
consistency, and patient safety

New too

Device ¢

S — new opportunities

evelopment experts as risk

managers — can aid in reducing SAEs

oooooooooooooo

Medical Device Regulation and Standards: Policy and Technical Aspects
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